
BoomFTP32 Help Index

 What is BoomFTP32?
 Licence/Copyright

Menu:
The BoomFTP32 application contains the following menu bar, which provides you assistance with this 
application: 

Connect menu Contains commands providing all operations with 
connect/disconnect to the remote computer

View menu Contains commands providing imaging of separate 
parts of program and setting of basic options

Local menu Contains commands providing basic operations with 
local pane

Remote menu Contains commands providing basic operations with 
remote pane

Help menu Contains commands providing helps over the 
different aspect of application

What is BoomFTP32?

BoomFTP32 is a Windows-based application for transferring files in between your PC (the “Local 
System”) and an FTP site (the “Remote Site”). Using BoomFTP32, you can connect to another system 
from your PC, browse files and folders on both systems, and transfer files between the systems. 

BoomFTP32 is a simple File Transfer Protocol (FTP) client application that complies with the Windows 
sockets (Winsock) standard. BoomFTP32, designed by Boomerang Software, Inc for Windows (TM) 
95/98/NT/2000, is similar to    well-known external FTP clients. BoomFTP32 can connect to any system 
that has a valid Internet Address and contains an FTP server program, allowing you to transfer files 
between a wide variety of systems, including Windows, OS\2, and UNIX systems. 
With this client you can access some FTP servers over the Internet or a company Intranet. You may 
operate with    FTP client exactly the same as the file functions of Windows Explorer, i.e. with the functions 
to copy, rename, delete, make directory, etc.
Hint: BoomFTP32 supports only the most important server types, like Unix, Windows NT, VMS and 
PC/TCP. If there is no directory listing shown after connecting, the server type is probably not supported. 
In this case you should use other FTP client, e.g. WS_FTP or CuteFTP.

You can use BoomFTP32 to:

· Create a connection between your local system and an FTP site

· Create and retain sites to automate the logon and connection to frequently used FTP sites

· Display and browse files and folders on both the local system and the FTP site

· Transfer one or more files between the local system and an FTP site (in either direction) 

· Access the vast store of information on anonymous FTP sites

· Resume interrupted file transfers. 

· Drag-and-drop between a local system and an FTP site.

· Prevent overwrite of newer files.

and more others.



Licence/Copyright 

This software is being provided to you under the terms and conditions mentioned herein and those of the 
License Agreement contained in this package or its documentation. By continuing this installation or by 
using this software you accept all the terms and conditions thereof.

Some parts of this program are patented and are protected by the applicable patent laws.

The ownership of this program is retained by Boomerang Software, Inc. This program is licensed to you 
for use under the terms mentioned herein and those of the license agreement contained in the 
documentation of the program. 

Boomerang Software, Inc. makes no warranty of representation, either expressed or implied, with respect 
to this software or documentation, its quality, performance, merchantability, or fitness for a particular 
purpose. As a result, this software and its documentation are licensed "AS IS" and you, the licensee is 
assuming the entire risk as to its quality and performance.

BOOMERANG SOFTWARE MAKES NO WARRANTIES OF ANY KIND, AND IS NOT RESPONSIBLE 
FOR ANY CONSEQUENTIAL DAMAGES OR FAULTS THAT MAY ARISE FROM YOUR USE OF SUCH 
PROGRAM.    IN NO EVENT WILL BOOMERANG SOFTWARE, INC. BE LIABLE FOR DIRECT, 
INDIRECT, SPECIAL, INCIDENTAL OR CONCEQUENTIAL DAMAGES ARISING OUT OF THE USE OR 
INABILITY TO USE THE SOFTWARE OR DOCUMENTATION, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.

BY CONTINUING THIS INSTALLATION OR BY USING THIS PROGRAM, YOU AGREE NOT TO 
REVERSE ENGINEER, DE-COMPILE OR DISASSEMBLE THE SOFTWARE, OR CREATE OTHER 
DERIVATIVE WORK.



Anonymous FTP

Most FTP sites support anonymous logins where you might    have not an account on the FTP site in 
order to transfer files. For most anonymous logins, the User ID is the word “anonymous” and the 
password is your e-mail address.



FTP site

An FTP site consists of an FTP server program located on an Internet host computer.



Connect menu items

The Connect menu contains the following commands, which provide you assistance with this application: 

Item Shortcut Description

New Window Ctrl+N Opens new window of BoomFtp32 program.

Connect… Ctrl+C Displays Connection library Dialog Box and 
enables user to manage connections and 
activate connection from library.

Quick Connect Ctrl+Q Displays Quick connect Dialog Box and 
enables user to quickly connect to FTP server 
without using connection’s library.

Disconnect Ctrl+D Disconnects the currently connection with the 
FTP server.

Transfer Mode >

Binary Sets transfer mode to Binary. In this mode all 
files are transferred in BIN Mode

ASCII Sets transfer mode to ASCII. In this mode all 
files are transferred in ASCII Mode

Auto Sets transfer mode to Auto. In this mode 
program determines transfer mode of every file 
by looking on ASCII extension list, specified in 
Options Dialog Box.

Exit Quits BoomFTP32.



View menu items

The View menu contains the following commands, which provide you assistance with this application: 

Item Shortcut Description

Toolbar Shows or hides general toolbar

Status Bar Shows or hides the status bar

Log Pane Shows or hides the Log Pane

Options… Ctrl+O Displays Options Dialog Box

Local Pane >

Large Icons Displays file list of local pane as large icons

Small Icons Displays file list of local pane as small icons

List Displays file list of local list as list

Details Displays file list of local pane with details

Arrange Icons >

By Name Arranges files in local pane by name

By Type Arranges files in local pane by type

By Size Arranges files in local pane by size

By Date Arranges files in local pane by modification 
date

Remote Pane >

Large Icons Displays file list of remote pane as large icons

Small Icons Displays file list of local pane as small icons

List Displays file list of local list as list

Details Displays file list of local pane with details

Arrange Icons >

By Name Arranges files in local pane by name

By Type Arranges files in local pane by type

By Size Arranges files in local pane by size

By Date Arranges files in local pane by modification 
date 

Local menu items

The Local menu contains the following commands, which provide you assistance with local pane of 
application: 

Item Shortcut Description

Open Enter Opens currently selected file or directory

Transfer Ctrl+PgUp Uploads currently selected files or directories 

Go up folder Backspace Goes one level up to the parent folder

Refresh F5 Refreshes content of current directory



Create Directory Creates new directory

Change Directory Changes current directory

Rename F2 Renames currently selected file or directory

Delete Del Deletes currently selected files or directories
Remote menu items

The Remote menu contains the following commands, which provide you assistance with remote pane of 
application: 

Item Shortcut Description

Open Enter Opens currently selected file or directory

Transfer Ctrl+PgDn Uploads currently selected files or directories 

Go up folder Backspace Goes one level up to the parent folder

Refresh F5 Refreshes content of current directory

Create Directory Creates new directory

Change Directory Changes current directory

Rename F2 Renames currently selected file or directory

Delete Del Deletes currently selected files or directories
Help menu commands

The Help menu contains the following commands, which provide you assistance with this application: 

Help Topics
Displays content of the online help
About BoomFTP32
Displays copyright and other information about BoomFTP32



Options Dialog Box

This is the main configuration dialog for BoomFTP32. Most settings can be changed in any tab of this 
dialog.

General Tab
Confirmation Tab
Sounds Tab
Connection Tab
Proxy Tab
File Types Tab
Options Dialog Box: General Tab

Default Download Directory Initial Local Directory unless Initial Local Directory 
specified in connection properties.

E-mail to use as password in 
anonymous logins

E-mail used as password in anonymous logins unless 
it is specified in connection properties.

Enable Logging Enables logging of protocol into the file.
Log File Name Specifies log file name to record, as a text file, the FTP 

commands, server responses, and transfers

Auto-Save View Settings Putting check mark in this check box makes 
BoomFTP32 to save all options to be saved on exit 
and restored next time you start the program.
.

Options Dialog Box: Confirmation Tab

Overwrite File or Directory Asks before overwriting file or directory.



Rename File or Directory Asks before renaming file or directory.
Delete File or Directory Asks before deleting file or directory.
Transfer File or Directory Asks before uploading/downloading file or directory.
Drag-Drop File or Directory Asks before uploading/downloading file or directory via 

drag-drop.
Disconnect Session Asks before disconnecting current session.
Options Dialog Box: Sounds Tab

Event Describes a list of sound Events 

Sound File Specified WAV files when corresponding event 

occurs.

Play Sound Playback at the selected event.

Stop Sound Stops playing.

Browse Browses for sound file.

No Sound Make selected event no sounds
Options Dialog Box: Connection Tab

Connect to the Internet using 
Local Area Network

Sets LAN Connection Mode

Connect to the Internet using 
Modem

Sets Dial-Up Connection Mode

Use the following Dial-Up 
networking connection

Specifies connection to use.



Add Adds new connection.
Properties Shows properties of selected 

connection.
Number of times to attempt 
connection

Number of retries during dialing.

Number of seconds to wait 
between attempts

Delay between attempts.

Automatically Hang up after 
disconnect

Hangs up after closing session

Options Dialog Box: Proxy Tab

Use Passive Transfer Mode Use PASV instead of PORT for data connection 
initializing.

Use Specific Proxy Settings Use Proxy to connect to FTP Server
Proxy Type Specifies used proxy type.
Proxy Address IP Address of proxy.
Port Port of proxy.
User Name User name used for authentication on proxy.
Password Password used for authentication on proxy.
Options Dialog Box  File Types Tab

This options’ tab lets you choose the ASCII method to transfer the files with specific extensions while 
AUTO transfer mode is set.

Use ASCII Transfer Mode for 
files with the following 
extensions

Default extensions list used to determine ASCII 
transfer mode in Auto Mode.



Add Add an extension to the ASCII extension list.
Modify Modifies extension in the ASCII extension list.
Delete Delete extension from the ASCII extension list.
Connection Properties

Connection Name Connection User friendly name.
Host Address of FTP Server to connect to.
Port Port of FTP Server to connect to.
Anonymous Login Specifies anonymous login to use.
User Name User Name used to Login.
Password Password used to Login.
Initial Directory Directories to show immediately after successful connect
(Local and Remote)
File Filter Wildcards to use as file filter.
Advanced…

Keep connection alive Enables Anti-Idle support.
Send NOOP Every NN minutes Send Anti-Idle command every NN(specified) minutes.
Time-out Timeout to wait for data.
Auto-retry count Number of retries during connecting process.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 
border you want to move. 

2. Press a DIRECTION key to move the border.

3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the BoomFTP32 window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Connect

Use this command to connect to remote computer’s file or folder and save information of connection in 
the list.

Shortcuts CTRL+C



Quick Connect

Use this command to quick connect to remote system. This mode of connections does not save your 
connection parameters. 

Shortcuts CTRL+Q



View Log Pane

Log Pane logs is a message area that logs all queries from the BoomFTP32 client (your PC) and all 
responses from the FTP site.



Connect/Disconnect

Use these buttons to connect/disconnect to/from host server.

Shortcuts CTRL+D



Exit command (File menu)

Use this command to end your BoomFTP32 session. You can also use the Close command in the 
application Control menu.    BoomFTP32 prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application’s Control menu button.
Keys: ALT+F4



View local pane’s files as Large Icons 

Displays file list of local pane as large icons.



View local pane’s files as Small Icons

Displays file list of local pane as small icons.



View local pane’s files as List

Displays file list of local pane as list.



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes the buttons for some of the most 
common commands in BoomFTP32, such as File Open. A check mark appears next to the menu item 
when the Toolbar is displayed.

See Toolbar for help when using the toolbar.



 Toolbars

BoomFTP32 program has main toolbar, toolbar for managing left (local) pane and toolbar for managing 
right (remote) pane



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the BoomFTP32 window.    To display or hide the status bar, 
use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button until the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAPThe Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Scrollbar

A vertical or horizontal bar at the side or bottom of a window that can be used with a mouse    to shift the 
contents of a window's client area either horizontally or vertically



View local pane’s files with Details

Displays file list of local pane with details.



Local pane’s files sort by Name

Arranges files in local pane by name.



Local pane’s files sort by Type

Arranges files in local pane by type.



Local pane’s files sort by Size

Arranges files in local pane by size.



Local pane’s files sort by Date

Arranges files in local pane by modification date.



View remote pane’s files as Large Icons

Displays file list of remote pane as large icons.



View remote pane’s files as Small Icons

Displays file list of remote pane as small icons.



New Window 

Opens a new window of BoomFTP32 program

Shortcuts CTRL+N



View remote pane’s files as List

Displays file list of remote pane as list.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using BoomFTP32 and various types of reference information. 

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of BoomFTP32.



Context Help command 

Use the Context Help command to obtain help on some portion of BoomFTP32.    When you choose the 
Toolbar’s Context Help button, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the BoomFTP32 window, such as another Toolbar button.    The Help topic will be shown 
for the item you clicked.

Shortcut
Keys: SHIFT+F1



View remote pane’s files with Details

Displays file list of remote pane with details.



Remote pane’s files sort by Name

Arranges files in remote pane by name



Remote pane’s files sort by Type

Arranges files in remote pane by type.



Remote pane’s files sort by Size

Arranges files in remote pane by size.



Minimize command (application Control menu)

Use this command to reduce the BoomFTP32 window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Remote pane’s files sort by Date

Arranges files in remote pane by modification date

.



Next Window command (document Control menu)

Use this command to switch to the next open document window. BoomFTP32 determines which window 
is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window. BoomFTP32 determines which 
window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Local pane’s open button

Opens currently selected file or directory

.



Local pane’s transfer button

Uploads currently selected files or directories.



Local pane’s create directory button

Creates new directory in the local pane area

. 



Local pane’s delete button

Deletes currently selected files or directories



Refresh local pane content

Refreshes content of the current directory.



Change current directory on local pane

Changes current directory. The change directory command is useful for changing to a directory on your 
local drive. BoomFTP32 will display the appropriate box, where you can choose a directory to change.



Local pane rename button

Renames currently selected file or directory.



Remote pane’s open button

Opens currently selected file or directory.



Remote pane’s transfer button

Uploads currently selected files or directories.



Refresh remote pane content

Refreshes content of the current directory.



Remote pane’s create new directory button

Creates new directory in remote system.



Change current directory on remote pane

Changes current directory. The change directory command is useful for changing to a directory on remote 
drive. BoomFTP32 will display the appropriate box, where you can choose folder to change to.



Remote pane rename button

Renames currently selected file or directory on remote system



Remote pane delete button

Delete currently selected files or directories from remote hosting server.



Set BIN transfer mode

Sets transfer mode to Binary. In this mode all files are transferred in BIN Mode.



Set ASCII transfer mode

Sets transfer mode to ASCII. In this mode all files are transferred in ASCII Mode.



Set AUTO transfer mode

Sets transfer mode to Auto. In this mode program determines transfer mode of every file by looking on 
ASCII extension list, specified in Options Dialog Box.



Local pane chup button
Goes one level up to the parent directory on local system.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the AFX_HIDP_xxx 
values from the [ALIAS] section of your .HPJ file, and author a topic for each AFX_HIDP_xxx value.    For 
example, AFX_HIDP_INVALID_FILENAME is the help topic for the Invalid Filename message box. >>



New command (File menu)

Use this command to create another window of BoomFTP32. 

Shortcuts

Toolbar:
Keys: CTRL+N



Remote pane chup button

Goes one level up to the parent directory on remote Hosting server.



Reliable Upload transfer files

BoomFTP32 resumes upload to FTP server from point where interrupted. 



Reliable download transfer files

BoomFTP32 resumes downloading from FTP servers from point where interrupted.



Main Frame

Main frame of BoomFTP32 consists from left (local) pane, right (remote) pane and log pane.



Main frame toolbar

The toolbar is displayed at the top of application window, right below the menu bar.    The toolbar provides 
quick mouse access to many tools used in BoomFTP32,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Open another window of BoomFTP32.

Quick connect to remote system. BoomFTP32 displays the QuickConnect 
dialog box, in which you can locate and open the desired remote system.
Connect to remote system. BoomFTP32 displays the Connect dialog box, 
in which you can manage, locate and open the desired remote hosting 
server.
Disconnect from remote hosting server.

BoomFTP32 displays the Options dialog box in which you can set basic 
configurations of program.
Sets transfer mode to Binary. In this mode all files are transferred in BIN 
Mode.
Sets transfer mode to ASCII. In this mode all files are transferred in ASCII 
Mode.
Sets transfer mode to Auto. In this mode program determines transfer 
mode by looking on ASCII extension list, specified in Options Dialog Box.
Upload currently selected files or directories to remote hosting server.

Reliable upload currently selected files or directories to remote hosting 
server
Download currently selected files or directories from remote hosting 
server.
Reliable download currently selected files or directories from remote 
hosting server



BOOMFTTYPE



Log pane 

Log Pane is a message area that logs all queries from the BoomFTP32 client (your PC) and all responses 
from the FTP site.



Local pane

Local pane is a area that shows current folders and its files tree on local system.



Remote pane

Remote pane is a area that shows current folders and its files tree on remote host computer.



Local pane’s toolbar

This toolbar provide managing file system showing on local pane.

Goes one level up to the parent directory.

Refreshes content of the current directory

Creates new directory in the local pane area

Changes current directory on your local drive

Renames currently selected file or directory

Delete currently selected files or directories

Displays file list of local pane as large icons

Displays file list of local pane as small icons

Displays file list of local pane as simple list

Displays file list of local pane with details



LOCALPANEACCEL 



Remote pane’s toolbar

This toolbar provide managing file system showing on remote pane. 

Goes one level up to the parent directory.

Refreshes content of the current directory

Creates new directory in the local pane area

Changes current directory on your local drive

Renames currently selected file or directory

Deletes currently selected files or directories

Displays file list of local pane as large icons

Displays file list of local pane as small icons

Displays file list of local pane as simple list

Displays file list of local pane with details



REMOTEPANEACCEL 



About Box

The About box will indicate the version number and also display the licensed-to information



Connection basic properties

Insert any site name as Connection Name and fill out all basic information for connection.

After pushing OK button your information will be stored in Connection list.



Quick Connect dialog

Set all basic parameters to connect via “Quick Connect” dialog box and push “Connect” button.



Connection advanced properties

--Set the Send ‘NOOP” Every to send no-operation warning message every time period specified. 

--Set Time-out parameter to have connection be interrupted while idling over time period      specified.

--Set Auto-Retry Count    to retry after specified number of attempts.

Checking Keep Connection Alive allows keeping connection turned on when client is in idle.



Connection Properties

Insert any site name as Connection Name and fill all basic information for connection.

After pushing OK button your information will store on Connection list.



Connect managing

You can create, edit, copy or delete site information you want to store in connection list using help of 
Connect dialog box.

To connect to any of the displayed sites, first click on the site name you want, and click then on the 
Connect button. 

Moreover, you can create Shortcut on the Desktop to your any favorite site by highlighting site name in 
the list and    clicking the “Create Shortcut on the Desktop” button.



OPTIONS



Dialing

Before dialing via modem using Dial-up connections you must write your registered name and login 
password for remote Host server.



DIALPROGRESS

Progress Bar shows dialing in progress



Redial Pause



Make new folder

If you wish to make a new folder on local or remote pane you must write new folder name in this dialog 
box.



Transfer processing information

Shows information transfer progressing



DELETEPROGRESS

 



OVERWRITECONFDLG

Warning message prompting about overwrite situation 



Registration 

If you purchased BoomFTP32 product you need register to get a license key. This will allow you to have 
the version updated on time. Fill out this order form to be registered.



REG 



Trial version

The Trial version message box shows how long time you can use this product until expiry date. 
Otherwise, you can register to unlock trial period latch.



VIEW_SWITCHPANE 



LOCAL_OPEN_FOLDERPANE 



REMOTE_OPEN_FOLDERPANE 






